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COPYRIGHT 

No part of this manual may be reproduced or transmitted without prior written 

permission of original manufacturer. 

The contents of this document are subject to change without notice. 

 

VERSION 20200408 
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SAFETY NOTICE 

Common safe type cautions 

Carefully read the following safety precautions for a thorough understanding. 

⚫ Follow the instructions and procedures described in this manual to operate this 

instrument safely. 

⚫ Carefully read all safety messages in this manual and the safety instructions on 

the instrument. 

⚫ Safety messages are labeled as indicated below. They are in combination with 

signal words of “WARNING” and “CAUTION” with the safety alert symbol  to 

call your attention to items or operations that could be dangerous to you or 

other persons using this instrument.  

 WARNING: Personal Danger 

Warning notes indicate any condition or practice, which if not strictly observed, 

could result in personal injury. 

 

 CAUTION: Possible damage to instrument 

Caution notes indicate any condition or practice, which if not strictly observed or 

remedied, could result in damage or destruction of the instrument. 

 

 NOTE：Notes indicate an area or subject of special merit, emphasizing either 

the function of the product or common errors in operation or maintenance. 

 

⚫ Do not operate this instrument in any manner not described in this manual. When 

encounter trouble with this instrument, ASK FOR HELP from original manufacturer or 

authorized distributors. 

⚫ The precautions described in this manual are carefully developed in an attempt to 

cover all the possible risks. However, it is also important that you are alert for 

unexpected incidents. Please operate with care. 
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 WARNING 

⚫ The instrument must be grounded properly to avoid electric shock. 

⚫ Keep away from live circuits: The operator must not disassemble the plastic case, 

replace components or adjust the machine. It is forbidden to disassemble the 

machine when the power is on. Please contact the professional after-sales 

engineer for instrument maintenance and repair If necessary. 

⚫ Power cord: The supplied power cord should be used. It must be replaced with a 

power cord of the same type and size if the power cord is damaged. Make sure 

that the plug is fully and securely inserted into the socket. 

⚫ Placement of the instrument: Do not place the instrument in a location where it is 

difficult to turn off the power. The instrument should be placed in a place with low 

humidity, low dust and away from water sources (pools, water pipes, etc.). The 

laboratory should be well ventilated and free from corrosive gases or strong 

magnetic fields. Do not place the instrument in a location that is wet or dusty. 

⚫ The vents at the lower end of the front door, the back panel, and the bottom plate 

are all set up for the ventilation and heat dissipation. Do not block or cover these 

vents to ensure normal operation and accurate experimental data of the 

instrument.  

⚫ Excessive ambient temperatures can affect test performance and even cause 

operational failures. Keep away from heating, hot gases, and all other sources of 

heat. Do not use the instrument in direct sunlight or strong light, so as not to affect 

the reliability of fluorescence detection. 

⚫ The power supply should be turned off when the instrument stops working. Please 

cut off the power supply and unplug the power plug when it is not used for a long 

time. Cover the instrument with soft cloth to prevent dust and foreign matter into 

it. 

 

 NOTE 

⚫ If any of the following occurs, please cut off the power supply immediately, unplug 

the power cord, and contact our after-sales service department as soon as 

possible. The company will arrange for professionals to repair. 

⚫ The liquid falls into the inside of the instrument. 

⚫ The instrument is rained or watered. 

⚫ There is abnormal sound or smell after the instrument is powered on. 
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⚫ The instrument falls or the casing is damaged. 

⚫ The function of the instrument has changed significantly. 
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Chapter1. Introduction 

 Instrument introduction 

1.1.1 Intended use 

The Eins-Sci E-QPCR real-time quantitative PCR system with 96-well is based on 

Fresnel lens optical signal acquisition technology, time-resolved signal separation 

technology and unique temperature control technology. It reaches international 

advanced level in sensitivity, multi-color crosstalk, temperature uniformity and accuracy. 

The instrument has 4/6 detecting channels and conform to multiplex PCR application. 

The instrument currently supports the application of all common real-time PCR 

assays, including relative quantification, absolute quantification, allelic discrimination 

assays, genotyping, and gradient PCR. It can be applied to multiple areas of basic research 

in medicine and biology, such as early clinical diagnosis of diseases, pathogen detection, 

tumor-related genes and drug resistance genes detection, gene expression levels in 

tissues or cells, transgenic animal and plant testing. 

1.1.2 Specifications 

Temperature control system 

Sample capacity 
0.1ml PCR tubes×96, 8×12 PCR plate or 96 well 

plate ×1 

Reaction volume 10-50 μl 

Thermal cycle technology Peltier 

Max. Heating/Cooling rate 6.0° C/s 

Heating temperature range 4 – 100 °C 

Temperature accuracy ± 0.2°C 

Temperature uniformity ±0.2℃ @60℃ ,  ±0.2℃ @95℃ 

Temperature gradient setting range 30–100°C 

Temperature gradient difference 

setting range 
1 – 36 °C 

Detection system 

Excitation light source 4/6 monochrome high efficiency LEDs 
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Detection device PMT 

Detection mode Time-resolved signal separating technology 

Excitation/detection wavelength range 455-650nm/510-715nm 

Fluorescent channels 4/6 channels 

Supported dye 

FAM/SYBR Green, VIC/JOE/HEX/TET, 

ABY/NED/TAMRA/Cy3, JUN, ROX/Texas Red, 

Mustang Purple, Cy5/LIZ 

Sensitivity Single copy gene 

Resolution 
1.33 folds copy number difference can be 

distinguished in single-plex qPCR 

Dynamic range 10 orders of magnitude copies 

Analysis mode 

Absolute quantification, Melting curve analysis 

Data output 

Original file, Excel data file, results include run settings, graph and tabular data results 

1.1.3 Characteristics 

1. High sensitivity  

 New optical signal detecting technology based on Fresnel lens, special high-

efficiency PMT and long-life maintenance-free LED, further improves the detection 

sensitivity of the prior technology. 

2. High accuracy 

Innovative scanning mode and time-resolved signal separating technology can 

effectively avoid cross-interference of inter-hole signals and multi-color fluorescence. 

3. Multiple detection 

Up to 4/6 fluorescence detection channels meet the requirement of multiplex PCR. 

4. Fast and stable 

Owing to unique edge temperature compensation technology, the thermal cycle 

rate, temperature uniformity and accuracy of the system reach a new height. 

5. Use-friendly software 
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Humanized and fully featured software provides complete solutions for sample 

testing, data calculating, and result analysis. 

6. Pursuing quality 

Internationalized product design ensures the superior performance of each 

instrument. 

1.1.4 Software functions 

1. Parameter setting function (fluorescence channel, temperature, time, cycle 

number, data processing method). 

2. Sample information recording function (experiment time, sample number, 

sample type, sample name). 

3. Detection data output function (threshold, fluorescence value, CT value, Tm 

value). 

4. Data result analysis function (absolute quantification, relative quantification). 

5. File storage function (setting data, running data, analysis results). 

6. Fault reminder function. 

 Declaration of conformity 

In compliance with the following safety standards: 

EN 61010-1 

EN 61010-2-020 

EN 61010-2-101 

In compliance with the following EMC standards: 

EN 61326-1/FCCPart15Subpart B/ IECS 001 

EN 61326-2-6:2006 

Associated EU guidelines: 

EMCguidelines:2004/108/EC 

LVD guidelines: 2006/95/EC 

This ISM device complies with Canadian ICES-001. 

Changes or modifications not expressly approved by the party responsible for 

compliance could void the user's authorization granted by the manufacturer to operate 
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the equipment. 

NOTE: This instrument has been tested and found to comply with the limits for a 

Class a digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 

provide reasonable protection against harmful interference when the instrument is 

operated in a commercial environment. The instrument generates, uses, and can radiate 

radio frequency energy and, if not installed and used in accordance with the user manual, 

may cause harmful interference to radio communications. Operation of instrument in a 

residential area is likely to cause harmful interference in which case the user will be 

required to correct the interference at his or her own expense. 
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Chapter2. INSTRUMENT STRUCTURE  

 Equipment Overview 

2.1.1 Structure 

 

2.1.2 Status light 

The meaning of the POW and STU lamp on the instrument is shown in the table 

below. 

 

Status light (STU) 

Power status light  

(POW) 

Power switch 

 

USB interface 

Transport lock 

Figure 2-1 Side view of the instrument 

Figure 2-2 Back view of the instrument 

Sample bin 

Air inlet 

Fan 

Fuse Power interface 

Entrance and exit  

button 
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 State Meaning 

POW Blue steady bright The system is powered on normally. 

STU 

Green flash slowly Reaction plate entrance and exit 

Green flash quickly The system is working or self-inspection 

Green steady bright The system is idle 

Red steady bright Failure, stop working 

2.1.3 Entrance and exit button 

The extending and retracting of the reaction plate are controlled by the entrance 

and exit button.  

 CAUTION: 

The extending and retracting of sample bin can operation only in the idle state of 

the instrument. The sample bin movement is not allowed in work process or self-

inspection process. 

2.1.4 Instrument switch 

The instrument switch is located on the back of the instrument. The ship-type switch 

is used. The "I" button is on and the "O" button is off. 

2.1.5 Data Interface                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                               

Data (USB) interface is used to connect computer with device. 

2.1.6 Air inlet 

The lower gap on the front panel is the air inlet. Blockage of objects should be 

avoided during the work. 

 WARNING: 

The air inlet is strictly forbidden to be used as a handle during transportation. 

 Temperature control system 

2.2.1 Heated lid 

The heated lid is located above the reaction plate. The holes position is correspond 
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to the reaction plate one by one. It is automatically positioned and pressing the reaction 

tube after the reaction plate enter the sample bin. 

2.2.2 Reaction plate 

The 96-well reaction plate is suitable for 96-well plates, eight-row tubes, and 100μl 

/200μl PCR tubes. Both white tube and transparent tube can be used. 

 NOTE: 

1) Only the same specification PCR reaction tube can be used in one experiment to 

ensure the accuracy of the experiment. 

2) Empty reactor tubes need to be placed at the sides of the reactor plate to support 

the heat lid when there are only several PCR reaction tubes in a single experiment, 

as shown in the figure below. 

 

2.2.3 Applicable supplies 

It is recommended to use 0.1ml PCR tube or 0.2ml Low-Profile PCR tube, as shown  

in the table below.  

Index Name Manufacturer Model 

1 
Low-Profile PCR Tubes 8-tube 

strip, white 
BioRad TLS0851 

2 

0.1ml LOW PROFILE, CLEAR PCR 

TUBES＆CAPS 8 STRIP TUBES＆

REAL TIME CAPS 

Axgen PCR-0108-LP-RT-C 

3 
0.1ml No Skirt H12 White 

/Transparent 
Nest 402111、402101 
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Chapter3. INSTALLATION 

Users are requested not to open the package privately after receiving the instrument. 

Please call the after-sales service department and make an appointment for installation. 

 NOTE： 

The company does not take any responsibility for (including but not limited to the 

following) the damage of the instrument, the malfunction of the instrument and 

personal injury caused by open the package and installation privately without the 

written permission of the company. And the company will not provide free 

maintenance services. Please understand. 

 Installation preparation 

3.1.1 Visual inspection 

Please check the appearance of the instrument carefully for damage after receiving 

it. Check the entry as follows (including but not limited to the following items): 

1) There is no obvious damage, bumping, deformation or rain immersion in the 

outer packing box; 

2) No damage or scratch of packaging bags (or film); 

3) No scratch or dirt on the shell; 

4) No scratch or rust on bare metal parts of equipment; 

5) No damage of random accessories or packaging bags. 

 Instrument installation 

3.2.1 Required environment conditions 

1) The instrument is for indoor installation only. Place the instrument on a firm, flat 

and horizontal platform, ensure the four feet of this instrument stand on the 

platform firmly. Avoid install on a slippery surface. 

2) Appropriate ambient temperature range: 5-30℃. The recommended ambient 

temperature is 20℃±5℃. Avoid temperature over 30℃ or direct exposure to 

sunlight. Ambient humidity: 20-80%. 

3) Keep away from heat source or liquid. 
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4) Keep clear of the instrument to guarantee the cooling efficiency, the space 

requirements for installation are as follows: 

 

 

 NOTE： 

The reliability of data will not be guaranteed if the instrument does not work under 

above environmental conditions. Indoor air conditioning should be used If the 

temperature and humidity exceed the appropriate range. However, direct air blowing 

instruments should be avoided, otherwise the reliability of operation data may be 

affected. 

3.2.2 Electrical requirements 

1. Power supply requirements: 220 V, 50/60 Hz, voltage fluctuation <10%. 

2. The maximum power consumption of the power outlet is 600W, and the 

grounding voltage is ≤5V. 

3. The instrument must be grounded properly. 

 WARNING: 

1) Improper grounding may result in personnel electric shock or instrument 

damage. 

2) Verify that the input voltage meets the requirements of the instrument and that 

a qualified fuse has been installed. 

Wall 

PC 

(1) 

Monitor

（1） 

QPCR 

（1） 

PC 

(2) 

Monitor

（2） 

QPCR 

（2） 

≥500mm 

≥300mm 
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3.2.3 Unlock 

The transport lock is locked when each instrument is packing from the factory, and 

the installer needs to open the transport lock as follows. 

1) Before first power up, insert the M4 inner hexagonal wrench attached to the 

instrument into the rubber hole on the top of the instrument, press down slightly 

and rotate 90 degrees counterclockwise, then loosen the wrench. The transport 

lock will pop out and the mechanical unlock is completed. 

 

Unlock operation 

2) When the instrument is powered on, the internal motor of the instrument 

performs the reset action automatically. The STU green indicator light is always 

on, and the unlocking is successful. 
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3.2.4 Connect to computer 

Inserted one end of the black power line into the power interface of the QPCR 

instrument, and the other end to the power supply outlet. Connect the white data line to 

the computer. 

 

 Software Installation 

The computer should be installed win10 system to adapt to the QPCR software. 

The software installation steps are as follows. 

1. Double click the left button to install the zip package. 

 

2. Unzip the file to the computer (recommend to install to D drive). Get the file 

installation package. 

 

3. Click to open the folder.  

4. Double-click “setup” to enter the installation guide. 

 

5. Click next. 
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6. Click next, you can click Browse to change the installation location.  

 

 

7. Click next. 
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8. Installing. 

 

9. Click close to complete. 

 

 System startup 

1. Start the computer monitor and host. 

2. Turn on the instrument power switch, the POW is steady blue; the STU is green 

flashing during the self-test of the instrument, then it is steady green; 
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3. Double-click the desktop software icon to launch the software; 

 

4. The interface after software start-up is as follows: 

 

 Instrument transportation 

Please call our after-sales service telephone for consultation if you need to move the 

instrument. The following operations should be performed before transportation: 

1) Power on the instrument. 

2) Press the entrance and exit button. Then put the 96-hole plate into the reaction 

plate for protection as shown below. Press it slightly to fit the hole. At last, press 

the entry and exit control button again to retract the reaction plate. 
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Put the 96-hole plate for protection 

3) Insert the M4 inner hexagonal wrench into the rubber hole on the top of the 

instrument, press down slightly and rotate 90 degrees clockwise, then loosen 

the wrench, and the spring does not pop out, the STU indicator status is red and 

green alternately. Now the mechanical lock is completed. 

The locking is failed if the indicator is steady red and the 3）step must be repeated. 

Lock verification: Press the entrance and exit button, if the sample bin does not 

extend, the lock is successful. 

 

4）Turn off the power and unplug the power cord and data cable. 

 NOTE： 

It is necessary to lock the transport lock to avoid bumping damage to 

important parts of the instrument before transporting, especially fluorescent 

detectors. 

 

 

Red light is always on when lock failure 
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Chapter4. SOFTWARE INTRODUCTION 

 Software startup 

Double-click the desktop icon to launch the application. 

 

 Interface introduction 

 

4.2.1 Menu Commands 

4.2.1.1 File menu 

The File menu contains commands used to new, open, save, save as and exit files. 

The menu also contains commands for exporting files as well as a list of recently-opened 

experiments. 

Status Bar 

Toolbar 
Menu Bar 
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1. New：Create a new experiment.  

To create a new experiment, click New in the File menu, press Ctrl+N, or click the 

new experiment button on the toolbar. The Properties Setting screen is displayed. 

2. Open：Open an existing experiment 

To open an existing experiment, click open in the File menu, press Ctrl+O, or click 

the open button  on the toolbar. The open dialog box will appear. Select the 

experiment to be opened. Click the open button at the bottom of the dialog box. 

3. Save：Experiment save 

To save an experiment, click save in the File menu, press Ctrl+S, or click the save 

button  on the toolbar. If the experiment has already been saved, no dialog box will 

be displayed and the experiment will be saved under its current name. If the experiment 

has not already been saved, the save as dialog box will open, allowing you to specify a 

file name and directory for storing the experiment. 

4. Save As：Save the file as 

To save a new experiment or to save an existing experiment under a new name, click 

save as in the file menu, and the save as dialog box will open. If the experiment was 

previously saved, the name of the experiment will appear in the File name field where it 

may be modified. If the experiment has not yet been saved, a default file name will appear 

in the File name field. You can select to either use the default file name or specify another 

file name. 

5. New Frame: You can create a new method file in a new window. 

6. Open in New Frame：When you are running an experiment, you can open a file that 

was saved in the past at the same time. 
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7. Save As Template：Save the file as a method file without saving the results. The 

storage location is User folder. 

8. Export：Exporting data to other applications 

 

To export the sample setup, fluorescence, amplification Ct, melt Tm and temperature 

to Microsoft Excel file, click export in the file menu. It can also export image of 

amplification curve. 

9. Recent experiments  

The File menu displays a list of the four most recently used experiments. Any 

experiment in the list may be opened by clicking on its file name. 

10. Exit：exit the program 

To exit the program, click the exit command in the File menu . If the open experiment 

has not been saved, the save current Experiment dialog box appears. 

4.2.1.2 Experiment menu 

 

1. Change: Modify/lock settings parameters 

Click the change in the Experiment or the change button on the toolbar before 

modifying the settings. The page parameters convert between locked and modified 

when click change.  

After clicking change, please note that the new file needs to be saved as a different 

file name, otherwise the original experimental data results will be overwritten and 

lost. 

2. Run: Run the experiment 
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To start running the experiment, click run in the experiment menu or the run button 

on the toolbar. 

3. Stop: Stop running 

To stop the experiment while the experiment is running, click stop in the experiment 

menu or the stop button on the toolbar. 

4. Add cycle 

Add cycles of segment when the experiment is running. Click OK. 

 

4.2.1.3 View menu 

 

1. Check the toolbar, the toolbar button is displayed. Unchecked, and the toolbar 

button is hidden; 

2. Check the status bar, the status bar button is displayed. Unchecked, and the 

status bar button is hidden. 

4.2.1.4 Help menu 

 

To display the software version number，click About QPCR in the Help menu or click 

the button on the toolbar. 
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4.2.2 Toolbar 

 

From left to right are new  , open , save , about QPCR , change (switch 

lock/modify status), run (start running), stop (stop running), Add Cycle. See 4.2.1 for 

details. 

Move in is the entry position. Move out is the out position. The function is equivalent 

to the entrance and exit button of the instrument top board. 

4.2.3 Status bar 

 

Properties Setting：Set experimental methods, instrument parameters, etc. 

Sample Setting：Set the name，type, location and fluorescent dye of the sample, etc. 

Program Setting：Set PCR reaction program. 

Amplification：Amplification curve. 

Melting: Melting curve. 

 Properties Setting 

4.3.1 Instrument Type 

Select instrument type of Accurate 96. 
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4.3.2 Experiment Setting 

 

1) Choose Experiment Type: Absolute analysis is suitable for absolute quantitative 

analysis or other analysis options. Melting Analysis just for melting analysis. 

2) Choose Chemistry. Select SYBR Green Reagents or TaqMan Reagents according 

to you experiment. 

4.3.3 System Setting 

Set the basic parameters of the system. 

 

1) Lid Setting. Choose “Use Lid Heater” means the hot lid is automatically heated 

to 100℃ in the experiment. 

2) Temperature Control. “Tube Temperature Mode” means that the temperature is 

based on the actual temperature in the tube instead of block temperature. 

3) PMT setting. Voltage is available in High, Middle, and Low. It is selected 

according to the amplification efficiency and defaults to Middle. 

4.3.4 Instrument Setting 

Set Melt Control and Material Setting 

1) Melt Control. The run mode includes Fast and Standard. The setting is valid 

when the experiment contains a melting curve. 

2) Material Setting. Tube Type include White tube and Transparent tube. Select 

according to the consumables used. 
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 Program setting 

4.4.1 Interface setting 

 

Add Segment: Add a new segment at the end of the reaction step. 

Insert Segment: Insert a new segment in front of the current selected segment. 

Add Step: Within this segment, add a new step after the current selected step. 

Insert Step: Within this segment, add a new step in front of the current selected step. 

Delete Step: Delete the currently selected reaction step. 

Melt Param: Signal acquisition frequency of Melting curve (Recommended set to 0.2) 

4.4.2 Parameter modification 

To modify the reaction temperature, time, cycle number, heating/Cooling rate, 

fluorescence collection point (End Point), click on the value to modify, or double-click 

anywhere on the current step and modify in the pop-up text box, as shown below. 
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1.  Temperature 

Fill in the temperature setting value of this step in the temperature item. 

If you need to set the temperature gradient, check Gradient. “Temperature” is the 

lowest temperature, “Up to” refers to the highest temperature. The temperature 

distribution increases from 1st to 12th column. For example, set the temperature gradient 

from 60°C to 70 °C, the specific temperature of each column will display in the lower right 

corner of the interface, as shown below. 

 

When viewing the data, to select the annealing step the temperature gradient will 

display on the right side of the interface. 
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2.  Time 

Fill in the set time in the Duration item. 

3. Heating/Cooling rate 

Fill in the Heating/Cooling rate in the Rate item. It is recommended 4.0 ℃/sec which 

is system default value.  

4. End Point 

None in the Check Type means no fluorescence will be collected, and End Point 

means the fluorescence is collected in this step. Normally you need to select End Point in 

the extension step of PCR. And select All Point in heating process of dissolution curve. 

For example, the settings are shown as below. 
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4.4.3 Save method 

File-save/save as, select the file storage location, and the default format is “.fsd”. 

 Sample Setting 

4.5.1 Select sample location 

Click or drag the mouse to select the sample position. Click on the bar of row or 

column to select this row/column. You can also use the shortcut buttons: Select All and 

Clear Wells. After selecting the sample location, select the corresponding sample type 

and load. 

4.5.2 Sample information setting 

4.5.2.1 Sample Type 

Select the sample type corresponding after selecting the hole position. There are six 

sample type to be seletect. 

Unknow：It refers to the sample to be tested in the experimental group; 

Standard: A sample of the target of interest that the copy number must be known 
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to setup an absolute standard curve, include DNA standards and RNA standard. 

NTC: No template control; 

Calibrator: Generally used for comparative quantification. 

Negative: Negative control, or no template control, used to exclude template 

contamination and test the reliability of the experiment. 

Positive: Positive control for testing the reliability of reagent and method. 

 

4.5.2.2 Load 

It means fluorescent channel, selected based on fluorescent PCR chemistries.  

The instrument is available in four/five channels. The channels are classified 

according to the absorption and emission wavelengths of the different fluorophores. 

 

Multiple channels can be selected simultaneously for multi-probe experiments. 

 NOTE: 

When the fifth channel (Cy3/NED/TAMRA) is selected, the third channel 

(VIC/HEX/JOE/TET) and the fourth channel (ROX/Texas/Rad) cannot be selected at the 

same time. The instrument will display an error message. Click “No” to reselect the 

Load Dye 

1 SYBR/LC/EVA/FAM1 

2 Cy5 

3 VIC/HEX/JOE/TET 

4 ROX/Texas/Rad 

5 Cy3/NED/TAMRA 
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fluorescence channel. 

 

4.5.2.3 Target Name 

The gene name corresponding to each channel can be selected after the 

fluorescence channel is selected. 

Fill in the gene name or click to select the edited gene name. Click on the Target 

Name in the View and the gene name will be displayed in the corresponding hole position. 

  

4.5.2.4 Sample Name 

Check the Sample in the view, select the corresponding hole, fill in the sample name  

or click  to select the edited sample name. The sample name is displayed in the 

corresponding hole position. 

 

4.5.2.5 Concentration 

Absolute quantification requires setting the concentration of standards.  
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Select the hole position of the same concentration, fill in the concentration value in 

the concentration box, check Load . At this point, click ‘Concentration’ in 

View and the concentration is displayed in the corresponding hole position. 

 

 

4.5.2.6 Replicate symbol 

Repeated wells of the same reaction need to be set to repeat for subsequent analysis. 

Select the repeating hole position, the serial number of the selected hole will appear 

in the selection box, select one of the serial number names, and check Load. 

 

 Start running 

Click run to start running. The running interface in shown as blow. 
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 Note： 

The computer screen must remain on while the instrument is running, and both the 
"screen off setting" and "sleep setting" of computer must be off. 

 Stop running 

The following prompt message will pop-up after the program finished. Click OK and 

the result data will be saved to the created file automatically. 

 

 Data export 

4.8.1 View Amplification Curves and Ct Value 

To open the existing experiment, click open in the File menu, press Ctrl+O, or click 

the open button  on the toolbar. Click Amplification in the status bar, the interface is 

as follows. To export the sample Setup, fluorescence and amplification Ct to Microsoft 

Excel file, click export in the file menu. It can also export image of amplification curve. 

Real-time fluorescence signals for each reaction hole 

Current  

reaction  

steps 

time remaining  

sample temperature 

hot lid temperature 

Amplification Curve Melting curve 

（SYBR Green） 
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4.8.1.1 Basic Analysis of Amplification Data：Amplification Curves. 

1) Analysis: Absolute quantitative analysis function, click the button to get the 

standard curve, see 5.1. 

Threshold：It can be adjusted when the spline method is selected. See Spline 

for details. 

2) Curve adjustment 

Double-click the left button in the amplification curve block diagram to display 

the curve control dialog box. 
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a) Legend：Hide or Show the sample name of the curve. 

b) Curve Property Operation 

For each cycle of fluorescence collection point options, click Reset Marks to 

display, Clear Marks to hide. 

c) Coordinate 

Both X-Ax and Y-Ax can be switched between Linear and logarithmic（Log）. 

The Y-axis is recommended to select the log value when adjust the fluorescence 

threshold with spline method.  

d) Background Grid：Select hide or show. 

e) Coordinate Range Adjustment：It can be modified by entering data or pulling 

the adjustment button. 

X-Axis Minimum 

 

X-Axis Maximum 

 

Y-Axis Minimum 

 

Y-Axis Maximum 
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4.8.1.2 Method 

The analysis methods include the following two kinds: 

1）Second Derivative Maximum  

The second derivative Maximum method gives the fluorescence threshold obtained 

by the optimization algorithm through the second derivative of the amplification curve, 

and then gets the corresponding CT value. It is the default method. 

2）Spline  

When the spline method is selected, and the threshold line appears. The threshold 

can be adjusted appropriately, curve coordinate Y-Ax selects Log, the amplification curve 

becomes a logarithmic curve as shown blow(right). Click on the threshold line to move 

the position or manually enter the threshold  .The corresponding CT 

value changes accordingly, which is displayed in the right information table. 

 

4.8.1.3 Ct value  

On the right side of the interface, there are information of position, type, channel 

and CT value of the sample. To save the CT value to the required folder, click save in the 

upper right corner and export it in Excel format. 

The software defaults to Individually, showing the amplification curve and Ct value 

for each sample. When Collectively is clicked, the average Ct value of repeated samples 

were displayed. 

Threshold line 

Y-Ax: Log 
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4.8.2 View melting curves and Tm value 

To open an existing experiment, click open in the File menu, press Ctrl+O, or click 

the open button  on the toolbar. Click Melting in the status bar, the interface is as 

follows. To export the fluorescence, melt Tm and temperature to Microsoft Excel file, click 

export in the file menu. It can also export image of melting curve. 

 

4.8.2.1 Analysis of Melting Data: Melting curve 

Click on Original Data, the original image appears on the right side of the melting 

curve derivative graph, as shown below. 

 

Double-click the left button in the melting curve block diagram, the curve control 

dialog box appears, and the adjustment method is adjusted with the amplification curve2). 

Melting curve 

Click on the sample to display the 

corresponding melting curve. 
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4.8.2.2 Tm value 

On the right side of the interface, there are information of position, type, channel 

and Tm value of the sample. To save the Tm value to the required folder, click save in the 

upper right corner and export it in Excel format. 
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Chapter5. DATA ANALYSIS 

 Absolute quantification 

5.1.1 Experiment setting 

Setting method refers to software introduction. 

 Note: 

1) In the properties setting, the experiment type must select absolute 

quantification, see 4.3.2. 

2) In the sample setting，the concentration of standards (see 4.5.2.5)and replicate 

symbol must be set (see 4.5.2.6). 

5.1.2 Data analysis 

1. After the end of the experiment, the status bar of the Amplification displays the 

amplification curve of the standards and samples. And the right interface shows 

the corresponding CT value. 

 

2. Analysis 

Click Analysis to display the standard curve. The standard curve equation, the R 

value and the amplification efficiency（eff）are shown above the standard curve. 

The copy number calculated from the standard curve is also displayed in the 

message box on the right surface. The Copies* refers to the setting 

concentration of standard. 
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3. Repeated hole data integration 

When the software defaults to select Individually, the amplification curve and CT 

value of single sample is shown. When select Collectively, the average data of the 

repeated samples are calculated, as shown in the following figure. 
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Chapter6. APPLICATIONS 

Flow chart 

 

 SYBR Green dye-based assays- GM soybean identification 

SYBR Green I dye is a fluorescent DNA-binding dye that binds to the minor groove 

of any dsDNA. Excited DNA-bound SYBR Green dye produces a much stronger 

fluorescent signal than unbound dye. If the target was present in the sample, sufficient 

accumulated PCR product will be produced at some point so that an amplification signal 

becomes visible. 

Taking the detection of genetically modified soybeans as an example, the absolute 

quantitative method was used to detection. 

6.1.1 Genomic DNA extraction 

Genomic DNA was extracted from GM soybean and soybean samples by plant 

genome extraction kit. The concentration and purity of DNA were detected by micro-

spectrophotometer, OD260/OD280 = 1.7-2.0. 

Start

Preparation of PCR
Reaction Solution

Tube/96-well plate 
centrifugation

Put sample into 

reaction plate

Instrument power up and selt-test

Computer power up then launch the  
software

Creat a new method

Sample setting

Start running

Data analysis

End

Program setting

Save method

Open a saved method

.

Instrument connect  to 
software
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6.1.2 Primer design 

Primer design for the 35S promoter which can be commonly found in GM soybeans. 

6.1.3 Preparation of standards 

1. PCR 

Set up 20µL PCR as detailed in the table below. 

Reagent Volume（µL） 

2×PCR mix  10 

F-primer（10µM） 0.5 

R-primer（10µM） 0.5 

GM soybean genomic DNA 1 

ddH2O 8 

Program： 

Pre-denaturation at 94 °C for 3 min; (denaturation at 94 °C for 20 s, annealing at 

55 °C for 20 s, extension at 72 °C for 30 s) 35 cycles; extension at 72 °C for 2 min. The 

replacement of the genome with ddH2O was negative. 

2. Purification of PCR products 

The amplified products were detected by agarose gel electrophoresis of 2%. The 

target fragments in gel were purified and recovered by gel recovery kit. 

The concentration was determined by nucleic acid protein analyzer. The dilution 

concentration of 10-fold series is 0.01-1 nmol/L, which is used as standard DNA. 

6.1.4 Preparation of qPCR Reaction Solution 

Set up 20µL qPCRs as detailed in the table below. 

Reagent Volume（µL） 

2ХSuper PreMix Plus(with SYBR Green I) 10 

F-primer（10µM） 0.5 

R-primer（10µM） 0.5 

Standard DNA/test sample DNA 3 

ddH2O 6 
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（ 2 Х Super PreMix Plus(with SYBR Green I) was purchased from TIANGEN 

Biochemical Technology Co., Ltd.） 

Repeat three copies of each sample. DdH2O was used instead of DNA as a negative 

control. 

 NOTE： 

Reaction solution is prepared at once and then sub-pack. The reaction tube needs 

to be centrifuged instantaneously. 

6.1.5 Power on 

Connect the power cable for the instrument. Turn on the instrument power switch 

and the instrument will start self-test. At the end of the self-test, the STU status light is 

steady green. 

6.1.6 Software startup 

Make sure the data cable is connected. Start the computer and double-click the 

desktop icon to launch the application. 

 

6.1.7 New experiment 

To create a new experiment, click New in the File menu, press Ctrl+N, or click the 

new experiment button on the toolbar. Then set the properties as shown below. 
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6.1.8 Program Setting 

Click Program Setting in the status bar to enter the program setting interface. 

Set the temperature, time, fluorescence collection point and cycles, as shown below. 

Note that the fluorescence acquisition in the extension phase （ 60 ℃ 30s ） of the 

amplification curve should be set to End Point, and the fluorescence acquisition of the 

melting curve（72℃-95℃）should be set to All Point. Melt Param is recommended to 

0.2. For details, see4.4. 

 

6.1.9 Sample Setting 

Click Sample Setting in the status bar to enter the sample setting interface. 

The standard has five concentration gradients, three repetitions for each 

concentration, select Standard type, SYBR channel，set the concentration and replicate 

symbol; Three replicates of the sample to be tested select Unknown type, SYBR channel, 

set the replicate symbol; No template control select NTC, SYBR channel, as shown below.  
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6.1.10  Save method 

To save method, click save as in the File menu. Select the file storage location as “D 

disk”, named 2019-SYBR-GMO. Or the storage path settings will automatically pop up 

after clicking Run. 

6.1.11  Sample entry 

Click entrance and exit control button，and put the reaction tube into the reaction 

plate. The sample position is consistent with the set position. Empty reactor tubes need 

to be placed at four corners of the reactor plate to support the heat lid. See 2.2.2. Click 

the button again, and the reaction plate moves in. 

6.1.12  Start running 

Click "run" to start running. The running interface is shown below. 
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6.1.13  Stop running 

The following prompt message will appear after the program finished. Click OK and 

the result data will be saved to the created file automatically. 

 

6.1.14  Data analysis 

Click Amplification in the status bar to enter the amplification interface. Click Analysis 

to get the standard curve. The copy numbers of the samples to be tested is displayed in 

the right information box. 

 

Click Collectively, the average data of the repeated samples are calculated, as shown in 

the following figure. 
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Click Melting in the status bar to enter the melting interface. The interface displays 

the derivative curve of the melting curve. Click on Original Data to display the original 

map of the melting curve. The Tm value is displayed in the information box on the right. 

 

 Taqman Assays- Liver cancer gene expression 

Taqman assays for target detection or quantification typically consists of two specific 

PCR primers and a Taqman probe. During PCR, the primers and probe hybridize with the 

target. DNA polymerase extends the primer upstream of the probe. If the probe is bound 

to the correct target sequence, the polymerase’s 5ʹ nuclease cleaves the probe activity, 

releasing a fragment containing the reporter dye. 

Taking the expression of the cell cycle kinase 4 CDK4 gene in primary carcinoma of 

the liver as an example, the important role of CDK4 in the development of liver cancer 

was studied by comparing the expression of this gene in liver cancer tissues and normal 

tissues. 
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6.2.1 Preparation of template 

1.  RNA extraction 

Extraction of total RNA from cryopreserved surgical specimens of liver cancer tissues 

and normal tissues using tissue RNA extraction kit. Assess RNA integrity on a denaturing 

gel or on an instrument such as micro-spectrophotometer. Ensure that the ratio of UV 

absorbance at 260 nm to the absorbance at 280 nm (A260/A280 ratio) is between 1.8 

and 2.0. 

2. Reverse transcription 

Reverse transcription of RNA to cDNA using a reverse transcription kit. 

6.2.2 Primer design 

Primer design for reference gene β-actin and target gene CDK4. Reporter is FAM, 

and quencher is TAMRA. 

6.2.3 Preparation of qPCR Reaction Solution 

Set up 20µL qPCR as detailed in the table below. 

Reagent Volume（µL） 

2ХGoldStar TaqMan Mixture(UNG) 10 

F-primer（10µM） 0.5 

R-primer（10µM） 0.5 

probe（10µM）（FAM-TAMRA） 0.5 

cDNA 3 

ddH2O 5.5 

 (2ХGoldStar TaqMan Mixture(UNG) was purchased from Beijing ComWin Biotech 

Co.,Ltd) 

The number of samples prepared is shown in the table below. cDNA was replaced 

with ddH2O as a negative control. 

 liver cancer tissues normal tissues 

Target gene CDK4 3 3 

Reference gene β-actin 3 3 
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 NOTE： 

Reaction liquid is prepared and then subpack. The reaction tube needs to be 

centrifuged instantaneously. 

6.2.4 Power on 

Connect the power cable for the instrument. Turn on the instrument power switch 

and the instrument will start self-test. At the end of the self-test, the STU status light is 

steady green. 

6.2.5 Software startup 

Make sure the data cable is connected. Start the computer and double-click the 

desktop icon to launch the application. 

 

6.2.6 New experiment 

To create a new experiment, click New in the File menu, press Ctrl+N, or click the 

new experiment button on the toolbar. Then set the properties as shown below.  

 

6.2.7 Program Setting 

Click Program Setting in the status bar to enter the program setting interface. 

Set the temperature, time, fluorescence collection point and cycles, as shown below. 
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Note that the fluorescence acquisition in the extension phase of the amplification curve 

should be set to End Point. 

 

6.2.8 Sample Setting 

Click Sample Setting in the status bar to enter the sample setting interface. 

The normal tissue was set to Calibrator, the liver cancer tissue was Unknown, CDK4 

was the target gene, and β-actin was the Reference gene. There were four tests, three 

repetitions for each test. Select the sample position and FAM fluorescence channel. As 

shown below. 

 

6.2.9 Save method 

To save method, click save as in the File menu. Select the file storage location as “D 

disk”, named 2019-FAM-liver. Or the storage path settings will automatically pop up after 

clicking Run. 
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6.2.10  Sample entry 

Click entrance and exit control button，and put the reaction tube into the reaction 

plate. The sample position is consistent with the set position. Empty reactor tubes need 

to be placed at four corners of the reactor plate to support the heat lid. See 2.2.2. Click 

the button again, and the reaction plate moves in. 

6.2.11  Start running 

Click "run" to start running. 

6.2.12  Stop running 

The following prompt message will appear after the program finished. Click OK and 

the result data will be automatically saved to the created file. 

 

6.2.13  Data analysis 

The amplification curves and Ct values are as follows. The expression level of the 

CDK4 gene relative to β-actin can be obtained from the Ct value. 

 

Ct value liver cancer tissues normal tissues 

Target gene CDK4 22.79 25.90 

Reference gene β-actin 15.96 18.09 
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Chapter7. TROUBLE SHOOTING 

Common failures. 

Index Trouble Possible reason Solution 

1 

The power switch of the 

instrument is turned on, 

but the instrument does 

not respond. 

1. The power cord is not 

connected correctly. 

2. The power supply is not 

energized. 

3. The fuse blows or 

bursts. 

1. Reconnect the 

instrument power cord 

2. Replace the fuse, see 8.4 

2 

Power status indicator 

does not light after 

turning on the power 

switch 

Indicator failure Contact the producer 

3 
Software and computer 

connection failed 

Incorrect data cable 

connection 

Close the software and 

reconnect the data cable 

4 

Abnormal fluorescence 

curve: straight line, partial 

data loss, etc. 

No amplification of the 

reaction, or the 

fluorescence collection 

point is set incorrectly 

1. Fluorescence collection 

point is set in the 

extension step 

2. Optimize reaction 

conditions  

5 

The difference in 

fluorescence value of 

each well in the absence 

of test tube is large, or the 

background is large 

Test tube hole or hot lid is 

contaminated 

Clean the reaction plate 

twice with 70% ethanol and 

purified water. 

6 Reagent evaporation 

The PCR tube has quality 

problems such as poor 

sealing, and the test tube 

cover or the sealing film is 

not used correctly. 

1. Replacement of 

qualified PCR  

2. Correct coating or 

capping 

7 
Abnormal fluorescence 

detection value 

1. Opening of hot lid 

during program running 

2. Photoelectric system 

damage 

1. Close the hot lid and re-

test it. 

2. Contact the producer 

3. Others 
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Chapter8. DAILY MAINTENANCE 

 Computer and software maintenance 

Maintenance project Requirement 

Use original computer and 

software 

Do not replace the computer yourself 

Do not install other third-party software yourself. 

Prevention of computer 

viruses 

Do not use mobile memory unrelated to the experiment 

It is best to format the USB flash drive on your computer 

before using a USB flash drive. 

It is best to use a dedicated USB flash drive. 

Insertion and removal of 

data lines 

Avoid inserting and removing connection data lines 

frequently 

Unplug the data cable with the computer and the host 

turned off 

 

 Reaction plate cleaning 

In order to ensure the accuracy of experimental data and reduce pollution, the QPCR 

reactor plate needs to be cleaned regularly every month. 

1. Click the entrance and exit button to open the sample bin. 

2. Dip 70% ethanol with a clean cotton swab and wipe the reaction well twice. 

3. Use a new cotton swab to extract pure water after the alcohol is completely 

evaporated, and then wipe the reaction well twice. 

4. Dry naturally;  

5. Close the sample bin. 

 Fan cleaning 

According to the frequency of use of QPCR, fans need to be cleaned regularly for 

half a year to one year. The fan is located inside the instrument backplane as shown below. 

After the instrument is powered off, use a Phillips screwdriver to open the backplane 

housing. The two sets of fans in the figure below can be cleaned with a brush. After 

cleaning, reinstall the backplane. 
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 Fuse 

8.4.1 Model 

Fuse diode，F5AL 250V 

8.4.2 Inspection and replacement 

1. Remove the fuse 

The fuse is located between the instrument switch and the power plug. Use a flat-

blade screwdriver to move the fuse out, as shown in the figure below. 

 

2. Pull out the fuse diode 

 

3. Detect fuse performance 

Adjust the multimeter to the diode position, the electrodes touch the ends of the 

fuse respectively, and the multimeter emits a “drop” sound, indicating that the fuse is 

normal. Otherwise, switch to a new fuse and re-test. 
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4. Put the fuse back into the instrument. 
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